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Chapter 1
IEC60730B Safety library example user's guide

For easier development of the IEC60730B application, the library also provides the example code. This example is distributed
through the MCUXpresso SDK website. This example user's guide describes how to set the hardware correctly and how to use
the example code with the IEC60730B Safety library.

The library user's guide is the main documentation for IEC60730B. It is also part this package and accessible at www.nxp.com/
IEC60730.
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Chapter 2
Hardware settings

This chapter describes setting up the hardware of the evaulation board. The MCU peripherals' setup is described later.
The IEC60730B library example for the family supports the following development boards:
» LPCxpresso55S69

To run the IEC60730B example application, it is neccessary to make some hardware settings. For the default configuration of
your development board, see the corresponding board user manual at www.nxp.com.

2.1 LPCXpresso55S69

To use the on-board debugger and power the board via USB, make sure that jumper J3 is set to Loc. Then connect the USB to
connector P6.

NOTE
If downloading to device does not work, try to press and hold the S1 button during download.
See the Hardware User’s Guide for more options.

The ADC module on LPCXpresso55S69 does not allow to connect the Bandgap internally to the ADC input. It is necessary to
connect these signals (for the Analog I/O test) as follows:

» VrefH 3.3 V - connected internally.
» VrefL - GND is connected internally.

» Bandgap - connect custom reference (for example 1.65 V) to PIO0_23 (P19-4). The expected value of the custom bandgap
can be set in the safety_config.hfile (#define ADC_EXTERNAL_PIN_LEVEL 1.65).

Figure 1. Hardware connection of LPCXpresso55S69
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Hardware settings

Test voltage of 1.65 V is provided by a resistor voltage divider from the VCC (3.3 V).
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Chapter 3
File structure

Safety is only a small part of the whole SDK package for your device. The source files of the IEC60730 library and examples are
in the middleware and in the board.

3.1 Library source files location
The library source files are in the middleware/safety _iec60730b/safety folder in the SDK package.

The folder has this structure:

+Mame Ext
&l
[commeon_test]
[compiler]
[core_test]
| | iblIEC&0TI0E_MCUX_wd O a
| | IECBOT30B_KEIL w4_0 lib
| | IECBOT30B_IAR_va_0 a
B iect0720b
Where:
« common_test contains the source files for the “peripheral” test — this is a common cross core.
» compiler - compiler support files.
» core_test contains the source files for the core-dependent test.

* jec60730b.his the main library header file.

The folder also contains binary lib files which are compiled for the IAR, KEIL, and MCUXpresso IDEs (see the release notes for
details).

3.2 Example of library handling code

The library-handling code and the example aplication are separate from the library file. The example source files and other SDK
examples are at this path:

boards/<your board>/demo_apps/safety _iec60730b/

The safety example code is shown in Figure 2.
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4+ Mame Ext
&1
[iar]
| [rncw]
[mdk]

B cafety_test_items h
B cafety_test_items c
o safety_iecB0730b

B cafety_cenfig

5 safety_cml_lpc

5 safety_cml_lpc

=] readme

B project_setup_lpcxpressoB45max
B project_setup_lpcxpressof45max
B pin_mux

B pin_mux

B main

5 isr

5 freemaster_cfg

5 clock_config

5 clock_config

B board

B board

=
2

[ T o T e i Sl o T o T :'.'Hh:'r:'r

Figure 2. Example of project structure in example folder

This folder contains the example source file and three folders for the IDE project file:
> Jjar
* mcux
* mdk
The following files are generated by the MCUXpresso configuration tool:
 clock_config.h
* clock_config.c
* pin_mux.c
e pin_mux.h

Other files are used only for safety examples and their contents are described in the next chapter.
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Chapter 4
Example application

The structure of the example is common in all supported IDEs (IAR, KEIL, MCUXpresso).

) safety iecb0TI0b - IAR Embedded Workbench IDE - Arm 8.40.1
File Edit View Praject J-link Tools Window Help

DlonEa@ = A& DC LS Q> B rE L
debug w
Files O .
E @ salety_iecB0730b - debug ™ o

M board
El board.c e
}— B boardh
& B clock_config.c .
— B clock_config h
& B pin_muxc a
L— & pin_munch
2 B CMSIS
= B component -
-8 i_--
- [ startc *
& [ starup_jarc ™
& [ veciors_ianc ™
L Blwectars_iarh
2 W device
— [ fzl_denice_registersh
— B LPCE45h
t— [ LPCB45_featuras.h
& [ system_LFCE45 ™
— B system_LPCE45h
= B coc
—E B drivers .
& 8 FreeMASTER ®
3 B |EC60730_Class_B L]
&1 & source
— [ freemaster_cfgh
— Bliseh
&[] miain.c ™
8 [ project_setup_lpcxpressoBdSmaxc s
— Bl project_setup_lpopressoB4Smaxh
& [ satety_cml_lpcc ®
— [ safety_cmi_lpch
— [ safety_config h
= [ safety_test_ilems.c ™
—— ] safety_test_femsh
=& M utilties .
= & Qutput

Figure 3. 1AR example application structure

The project contains the CMSIS, SDK, library, and safety example-related folders.

The safety-related folders are the following:
» Board - this folder contains the files related to the board used (clock _config.h, pin_config.h, board.h, and so on).
» CPU- this folder contains the startup code and vectors table.

* |[EC60730 Class_B - files for the IEC60730B Safety library.
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Example application

» Source - source file for the safety example (see the next explanation).

The example project hiearchy is shown in Figure 4.

isr.h
freemaster_cfg.h

safety configh ——® main.c

l l |

project_setup.c safety_cm0.c safety_test_items.c
project_setup.h safety_cm0_h safety_test_items.h

|

IECE0730 Class B library

Figure 4. Example of project hiearchy

Figure 4 shows that the functions in the project_setup.cfile are called from the main.cfile. The library-handling functions are
located in the safety_cm33_Ipc.cfile and also called from the main.cfile.

The main example aplication header file safety_config.h contains all definitions for running the safety test in examples. The
safety _test_items.cfile declares the structures for the DIO (or TSI) safety test. The project_sefup_<your_board>.cfile contains
the setup functions (clock, port, UART, and so on). The safety_cm33_Ipc.c file contains the handling function for safety routines
from the IEC60730B library and also the test-initialization function for safety.

4.1 Example settings - safety_config.h
The main example settings header file is safety_config.h. The neccessary macros for safety example are defined in this file.

The "switch macros", which allow the user to turn off calling the safety test, are defined in the beginning. When starting, turn off
the FLASH test and the WDOG test. On LPC devices, turn off also the Clock test.

/* This macro enables infinity while loop in SafetyErrorHandling() function */

#define SAFETY_ERROR_ACTION 1

/* TEST SWITCHES - for debugging it is better fo turn the flash test and watchdog OFF */
#define ADC_TEST_ENABLED 0

#define CLOCK_TEST_ENABLED 1
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#define DIO_TEST_ENABLED 1
#define FLASH_TEST_ENABLED 1
#define PC_TEST_ENABLED 1
#define WATCHDOG_ENABLED 1

Other defines are used to configure the safety test as a parameter to a function or for fill structures.

4.2 safety_test_items.c file
The safety test ifems.c and .Afiles are the configuration files for the DIO test.

The file contains the fs_dio_test <platform>_tlist of structures. The pointers to these structures are colected in the
dio_safety test itemsf] array, which is used in the example application.

fs_dio_test Ipc t dio_safety _test ifem_0=/*P1_8 "%

{

.Jocon_mode_shift = IOCON_PIO_MODE_SHIFT, /*Device depend’/

.pPort_byte = (uint8_t *)&(GPIO->B[1][8]), /*adress of byte register in GPIO”/

.PPort_dir = (uint32_t *)&(GPIO->DIR[1]), /* asress of dir1 register/

.pPort_locon = (uint32_t *)&(IOCON->PIO[1][8]), /* Adress of concrete IOCON register?/

.pinNum = 8, /*Position in DIR registor’/ .gpio_clkc_shift = SYSCON_AHBCLKCTRLO GPIO1_SHIFT

¥

/* NULL terminated array of pointers fo dio_test _t ifems for safety DIO test */

fs_dlio_test _lpc_t *dio_safety test _items[] = { &dio_safety test item_0, &dio_safety test item_1, NULL };

4.3 Source file - safety_safety_cm33_Ipc.c/.h

The safety_cm33_Ipc.c source file and the correspond * /A file contain a library handling function. Each function contains a
detection. If a safety error ocurrs, the SafetyErrorHandling() function is called.
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Chapter 5
Running example

For the first run of the example on your hardware, it is recomended to turn off Flash, WDOG, Clock, AlO, and DIO test. In the
next step, turn on step by step.

When the WDOG is turned off and a safety error happens, the example stays in an endless loop.

5.1 FreeMASTER monitoring

FreeMASTER is used as the external PC tool for real-time monitoring. FreeMASTER is also implemented in the IEC60730B
safety examples. For simplicity reasons, the MAP file is the source of the variable address. Before connecting FreeMASTER to
your application, make sure that the application is running.

Running FreeMASTER:

Download and install FreeMASTER from www.nxp.com/freemaster.
The example project is in the safety.pmp file. Open it.
Check the project settings for your application:
» Open Project->Options ->MAP Files - this must point to your output files

IAR IDE and ARM Keil IDE

Navigate to the boards/<your _board>/demo_apps/safety_iec60730b/<compiler>/<debug or release>/*outfile.

MCUXpresso IDE
Navigate to the <workspace>/<project_name>/<Debug or Release>/<project_name>.axffile.

Options *

Comm MAP Files ] Pack Dirl HTML Pages l Dema Mode ] Views & Bars l

Default symbol file: ]..R..R..R..Rboards\frdmkv'l‘Iz\demo_appS‘Lsafety_iecSD??.DbRiar\debug‘Lc
File format: ]Binary ELF with DWARF2/DWARF4 dbg format LJ Edit De
1ecB0730b\iardebug) N ETS

Del

View

List of all valid
symbol files:

AA A \boards\frdmkvl12\demo_apps\safe

MNote: The file selected in the list will be used as default symbol file
when the projectis opened

-On Load
]_ Letthe user select staring symboal file
[¥ Synchronize variables each time the symbol file loads

[¥ List errors (vaniables using undefined symbaols)
(@ Always 1 Exceptafter projectload

OK | Cancel

Figure 5. Example of setting MAP files for FRDM-KV11 board

* Open Project ->Options ->Comm and select a correct RS-232 connection and speed. The speed of conncetion is in the
safety_config.h file Macros "SERIAL_BAUD RATE".
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Running example

Options

Comm | MAP Files | Pack Dir | HTML Pages | Demo Mode | Views & Bars

— Communication

Port [COM_ALL

Speed: |192i}E|- v| Timeouts... |

v | |AlICOM ports will be scanned

 Plug-in Module: I

Caornect string |

[w Save settings to projectfile

=l

[T Save settings to registry. use it as default

Canfigure..

=

— Commupication state on startup and on project load

" Open port at startup
/@ Do notopen port at startup
(" Store port state on exit, apply it on startup

[v Store state to projectfile. apply upon its load

Advanced... |

o |

Cancel

Apply

Figure 6. Setting UART speed

Now you can connect to the development board by pressing "CTRL+G" or clicking the "GQO" button:

| @ safety.pmp - FreeMASTER
| File Edit View Explorer Project Tools Help

SEH@D - =
I

G Bf & s ) 21 |20 Roes 3 R [TE| 4 6 K2 Tehoma

|
. block descripti
!7! @ Start communication (Cerl+G) E rton

: Open port and and start
¥ Demq

communication Name Value |__Unit | Period I
4 Demo recoraer ——-safetyCommon.CPU_control_test_result 0xdl HEX 1000
q_sSafetyCommon.CPU_non_stacked_test_result 0x0 HEX 1000
| g_sSafetyCommon.CPU_primask_test result 0x0 HEX 1000
| g_sSafetyCommon.CPU_req_test_result 00 HEX 1000
| g_sSafetyClockTest.clockTestContext 102 DEC 100
| g_sSafetyClockT est.clockTestExpected 102 DEC 1000
| g_sFlashConfig.checksum16 0xe25h HEX 1000
| g_sSafetyCommon.FLASH_test_result Oxe25h HEX 1000
| g_sSafetyCommon.CLOCK_test_result 0xi HEX 1000
| g_sSafetyCommon.DIO_input_test_result 0x%0 HEX 1000
! | g_sSafetyCommon.DIO_output_test_result 0x0 HEX 1000
| g_sSafetyCommon.DIO_short_test_result 0x0 HEX 1000
| | g_sSafetyCommon.AIO_test_result 0%704 HEX 1000
| g_sSafetyCommon.PC_test_result 0x0 HEX 1000
| g_sSafetyCommon.RAM_test_result Ol HEX 1000
| g_sSafetyCommon.STACK_test_result 0x0 HEX 1000
| g_sSafetyWdTest.watchdogResets 1] DEC 1000
| g_sSafetyCommon.safetyErrors 0x%0 HEX 1000

| E‘Application Co... !E‘Var\able Stimulus

;Open port and and start communication

Figure 7. Safety example FMSTR application

Not connected

Usually, an AlO test is a number of results oscillating between 0x0 and 0x704 (test passed and test in progress).
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Chapter 6
IEC60730B tests

The library contains the following tests:
* Analog I/O test
* Clock test
* CPU register test
+ Digital I/0 test
* Invariable memory (Flash) test
» Variable memory (Ram) test
» Program couter test
+ Stack test
» Watchdog test

The following chapters describe each test with focus on the example application (debugging).

6.1 AIlO test

The analog IO test procedure performs the plausibility check of the digital 10 interface of the processor. The analog 10 test can
be performed once after the MCU reset and also during runtime.

There are three values tested in the application:
* VrefH
* VrefL
« Bandgap

Ensure that the ADC peripheral is setup correctly before calling the AlO test. In some cases, it is necessary to connect this signal
externally by wire to the corresponding pin. The test is perfomed in a sequence, as defined in the safety_config.hfile:

/*ADC test %/

{1

{(uint32_YADC_MIN_LIMIT(0), (uint32_HADC_MAX_LIMIT(60)}, |
{(uint32_)ADC_MIN_LIMITAADC_MAX), (uint32_t)ADC_MAX_LIMIT(ADC_MAX)},|
{(uint32_ADC_MIN_LIMITIADC_BANDGAP_LEVEL_RAW),
(uint32_ADC_MAX_LIMITIADC_BANDGAP_LEVEL_RAW)} }

#define FS_CFG_AIO_CHANNELS _INIT {6, 5, 4} /* ADC Channels for V_ref], V_refh, bandgap */

An example of the setting is shown above. The "FS_CFG_AlIO_CHANNELS_INIT"macro defines that ADC channel 6 is tested
first, with limits corresponding to VrefL (GND). Channel 5 is tested next, with limits of VrefH (VCC). Channel 4 is tested next, with
limits for the bandgap.
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IEC60730B tests

6.2 Clock test

The clock test procedure tests the oscilator frequency for the CPU core in the wrong frequency condition.

NOTE
The default clock setting from the SDK library is used in the example. For a real application, ensure that the
reference clock source is not dependent on the primary (tested) clock.

6.3 CPU register

The CPU register test procedure tests all CPU registers for the stuck-at condition (except for the program counter register). The
program counter test is implemented as a stand-alone safety routine.

Some tests stay in an endless loop in case of an error, others return a corresponding error message.

6.4 DIO test
The Digital Input/Output (DIO) test procedure performs the plausibility check of the processor's digital 10 interface.

NOTE
Make sure that the time between the "set" and "get" functions is sufficient for the GPIO peripheral speed.

6.5 Invariable memory test

The invariable (Flash) memory test provides a CRC check of a dedicated part of memory. This test is turned off by default in the
safety_config.hfile.

The test consists of two parts:

» Post-build CRC calculation of the dedicated memory.

* Runtime CRC calculation and comparison with the post-build result.
The post-build calculation is different for each IDE:

In the IAR IDE, the CRC is calculated by the IDE directly using the linker (see Options->Build Action). The Flash test is fully
integrated to the example project in the IAR IDE. It is necessary only to turn this test on in the safety_config.h file.

In the Arm Keil IDE, it is necessary to use a third-party tool (Srecord):
» Srecord is added to the presented example by default.

» Check if Option -> User -> AfterBuild contains "/crc_keil.bat"and the checkbox is selected (it should be filled and checked
by default).

» Turn on the Flash test in the safety_config.hfile.
» The final post-processed image is downloaded to the ROM memory using the "Download" button.

» For more information on using Srecord in Arm Keil IDE, see Calculating Post-Build CRC in Arm”® Keil® (document
AN12520).

In the MCUXpresso IDE:

 Check if the post-build actions are set: "${ProjDirPath}'/linker/crc_mcux.bat "8{BuildArtifactFileBaseName}". It should be
filled by default.

» The final post-processed image is downloaded to the ROM memory using the GUI Flash Tool (choose the
<board>_safety iec60730b_CRC.binfile).

» The "Attach only" option must be set if you want to debug the application.

* Turn on the Flash test in the safety_config.hfile.
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NOTE
When you debug your application with the Flash test turned on, be careful using the breakpoint. The software
breakpoint usually changes the CRC result and causes a safety error.

6.6 Variable memory test
The variable memory on the supported MCU is an on-chip RAM.
The RAM memory test is provided by the MarchC or MarchX tests.

The test copies a block of memory to the backup area defined by the linker. Be sure that the BLOCK_SIZE parameter is smaller
than the backup area defined by the linker.

NOTE
This test cannot be interupted.

6.7 Program counter test
The CPU program counter register test procedure tests the CPU program counter register for the stuck-at condition. The program
counter register test can be performed once after the MCU reset and also during runtime.

NOTE
The program counter test cannot be interrupted.

6.8 Stack test

This test routine is used to test the overflow and underflow conditions of the application stack. The testing of the stuck-at faults
in the memory area occupied by the stack is covered by the variable memory test. The overflow or underflow of the stack can
occur if the stack is incorrectly controlled or by defining the "too-low" stack area for the given application.

NOTE
Choose a correct pattern to fill the tested area. This pattern must be unique to the application.

6.9 Watchdog test

The watchdog test provides the testing of the watchdog timer functionality. The test is run only once after the reset. The test
causes the WDOG reset and compares the preset time for the WDOG reset to the real time.

For this test to run correctly, it is necessary to keep the WDOG_backup variable in a part of memory which is not corrupeted by
the WDOG reset.

NOTE
Some debuggers do not allow the WDOG reset. Due to this, it is necessary to turn off the WDOG when debugging
the application.
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